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Abstract
The compartmentalization of cellular functions in complex membranous organelles

is a key feature of eukaryotic cells. To cope with the enormous complexity of traf-

ficking pathways that connect these compartments, new approaches need to be con-

sidered and introduced into the field of cell biology. We exploit the advantages of the

“micropatterning technique,” which is to bring cells to adopt a highly reproducible
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shape, and probabilistic density mapping, which quantifies spatial organization of

trafficking compartments, to study regulatory mechanisms of intracellular traffick-

ing. Here, we provide a protocol to analyze and quantify alterations in trafficking

compartments upon cellular manipulation. We demonstrate how this approach can

be employed to study the regulation of Rab6-labeled transport carriers by the

cytoskeleton.
INTRODUCTION

Intracellular trafficking pathways
The endomembranous system of eukaryotic cells comprises several diverse organelles

and tubular–vesicular transport carriers that are dynamic and highly interconnected by

multiple routes. Classically, intracellular trafficking routes are divided into the secre-

tory (or anterograde) pathway and the endocytic pathway. The endoplasmic reticulum

(ER), the intermediate compartment (IC), the Golgi apparatus, and the trans-Golgi net-
work (TGN) are considered to belong to the secretory pathway, whereas early (sorting)

endosomes, late endosomes, lysosomes, and the endocytic recycling compartment

(ERC) are most often classified to the endocytic pathway. Although functionally dis-

tinct, the secretory and endocytic pathways have parallel functions (Saraste & Goud,

2007). These include membrane and receptor recycling to maintain the integrity of

the ER and the plasma membrane, respectively (Griffiths, Back, & Marsh, 1989;

Martinez-Menarguez, Geuze, Slot, & Klumperman, 1999; Sannerud, Saraste, &

Goud, 2003). Furthermore, their respectivemolecularmachineries resemble each other

(Bonifacino&Glick, 2004;Chia&Gleeson, 2011). Importantly, bothpathways seemto

partly overlap and to be intertwined at various branch points (Ellis, Potter, Cresawn, &

Weisz, 2006; Lipschutz, Lingappa, &Mostov, 2003; Sannerud et al., 2003; Toikkanen,

Miller,Soderlund, Jantti,&Keranen,2003).Forexample, theERCcansortmolecules to

the TGN (Wilcke et al., 2000) and the IC can contribute to endocytosis (Becker,

Volchuk, & Rothman, 2005).

Although allowing the segregation of cellular processes, cellular compartmental-

ization demands an efficient and regulated communication among those compart-

ments. Small GTPases of the Rab family are key regulators of intracellular

trafficking, present in both secretory and endocytic pathways. There are over 60

members in human and they are highly conserved (found in all eukaryotes)

(Pereira-Leal & Seabra, 2001). In their active form (GTP-bound), Rabs recruit a di-

verse range of effector proteins, such as molecular motors, lipid kinases, tethering

factors, and scaffolding proteins, controlling the formation of transport carriers from

donor membranes, their movement along cytoskeletal tracks, and their tethering/fu-

sion with target membranes (Stenmark, 2009). Because Rab proteins are restricted to

specific organelles or membrane microdomains, their presence not only regulates the

trafficking throughout compartments but also defines their identity (Hutagalung &
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Novick, 2011). Rab proteins are themselves under a strict spatiotemporal control by a

complex network of proteins. Guanine nucleotide exchange factors (GEFs) stimulate

the exchange GDP for GTP and thus activate Rab proteins and GTPase-activating

proteins (GAPs) facilitate GTP hydrolysis and thus deactivate Rabs. Recent findings

indicate that Rab proteins not only regulate individual transport steps but also

function in a coordinated fashion, orchestrating sequential steps along transport

pathways. An upstream Rab can recruit a GEF for a downstream Rab. In addition,

a downstream Rab can recruit a GAP that will inactivate the upstream Rab

(Rab GTPase cascades). Such a mechanism appears to be crucial to ensure

continuity and directionality in membrane traffic (Jean & Kiger, 2012; Markgraf,

Peplowska, & Ungermann, 2007).

The establishment and dynamics of trafficking routes and their regulation by Rab

proteins are still not fully understood. Major challenges are the dynamic nature

of trafficking events. Additionally, many trafficking compartments are spatially

dispersed. Unlike compact structures such as the Golgi apparatus in mammalian cells

and the ERC, endosomes and various transport carriers are present in high numbers

and are located throughout the cells. This dispersed localization makes it very chal-

lenging to detect alterations in the compartment due to experimental manipulation or

in pathological situations such as cancer development. To tackle these challenges, it

is crucial to develop new quantitative approaches. Here, we present a method that

allies cell normalization by micropatterning with probabilistic density mapping

to quantitatively study intracellular trafficking pathways. Figure 20.1 outlines the

probabilistic density-mapping procedure for a single cell and a cell population.
Cell confinement by micropatterning techniques
The structured microenvironment of a tissue or organ imposes spatial restrictions on

cells. These spatial cues force cells to take a specific, reproducible organization that

is characteristic of tissues. Spatial cues have preponderant roles in a wide range of

cellular functions, such as cell polarity, differentiation, division, and signaling

(Gumbiner, 1996). Yet, classical in vitro cultured mammalian cells show strong

cell-to-cell variations in morphology (Sigal et al., 2006). This heterogeneity has been

attributed to unconstrained and dynamic cell shape, a consequence of the fact that

cells move and constantly rearrange intracellular trafficking pathways. Furthermore,

cells adapt to their local population context. Population size, local cell density, and

position within a cellular islet have all been shown to determine cellular morphology

and responsiveness (Snijder et al., 2009). The resulting heterogeneity hampers the

understanding of the regulation of cellular trafficking pathways. In an attempt to

transfer some of the in situ cues into classical cell culture conditions, various micro-

fabricated substrates have been used in in vitro cell culture (Folch & Toner, 2000).

Micropatterning technique comprises the fabrication of adhesive and nonadhesive

regions that impose a defined geometry to cells upon adhesion. Throughout the years,

the application of micropatterning technology has increased in cell biological stud-

ies, revealing important aspects of cell physiology. For instance, mesenchymal stem



FIGURE 20.1

Outline of the probabilistic density-mapping procedure exemplified for one single cell and

cell populations. (A) Probabilistic density mapping of intracellular compartments requires cell

normalization by micropatterning, extraction of point coordinates of imaged intracellular

structures by segmentation, and kernel density estimation. (B) Example of this analysis for

one single cell: the shape of the cell is first normalized by adhesion on amicropatterned shape

(such as a crossbow), fluorescently labeled intracellular structures are transformed into

point coordinates, and each of them is replaced by a Gaussian function (kernels) with mean

zero and an optimized variance. Kernels are summed revealing the underlying density

throughout the cell, where “red” corresponds to themost dense cellular regions. (C) Typically,

several thousands of coordinates from several tens of normalized cells are used to

calculate the density map of a population of cells.
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cells plated on micropatterns differentiate either into adipocytes or osteoblasts,

depending on the size and geometry of the pattern (McBeath, Pirone, Nelson,

Bhadriraju, & Chen, 2004), revealing the importance of adhesive cues in cell fate.

By applying controlled changes in micropattern geometry, it was also shown that cell

adhesion determines the orientation of the mitotic spindle (Thery et al., 2005) and the

orientation of the cell polarity axis (Thery et al., 2006).

These and other studies show that in vitro confinement of cell shape mimics the

restriction of space that cells experience in body tissues (Gumbiner, 1996). Addition-

ally, cell confinement on adhesive micropatterns of defined shapes normalizes
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cellular shape, inner organization (Fig. 20.1B and C), and responsiveness to a given

manipulation. Consequently, cell normalization allows the reduction of the number

of analyzed cells required for statistically significant results. We showed that subtle

drug effects on intracellular compartment were assessable using less than 20 micro-

patterned cells (Duong, Goud, & Schauer, 2012; Schauer et al., 2010). Importantly,

these effects could not be detected in conventionally grown unrestrained cells.

Normalization additionally allows simplification and automatization of image

analysis that is required for unbiased studies or high-throughput approaches.
Probabilistic density mapping of intracellular compartments
A primary method for studying cellular function is to examine fluorescently labeled

proteins after a given manipulation. Despite of the central role of morphology

comparisons in cell biological approaches, few statistical tools are available that

allow to quantify the similarity or difference of fluorescent images containing mul-

tivariate data. Because direct visualization of a large number of structures is not able

to reveal details of the underlying spatial organization, statistical methods such as

density mapping are required to visualize this organization (Fig. 20.1B and C).

Density mapping is based on kernel density estimation, a set of advanced statistical

techniques that are well suited to analyze multivariate data. Kernel estimators are

convolutions, as each data point is blurred, in an inverse operation of the more widely

known deconvolution, which takes a blurry image and sharpens it. This blurring

or smoothing is a mathematical representation that an observed structure should

represent not only itself but also other nearby structures that were not observed.

The level of smoothing is the most important parameter to estimate optimally and

has been the subject of much research, as it is also the most mathematically difficult

to resolve (Duong & Hazelton, 2003, 2005). An oversmoothing leads to estimates

that obscure the detailed structure of the data, whereas an undersmoothing leads to

estimates that are too noisy with spurious data artifacts (Fig. 20.2). The mathematical

complexity of kernel density estimators has thus historically limited their use beyond
FIGURE 20.2

The smoothing parameter. The level of smoothing is themost important parameter to estimate

optimally in a density map. An example is given of an oversmoothing that obscures the

detailed structure of the data and an undersmoothing that leads to estimates that are too

noisy with spurious data artifacts and optimal smoothing.
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the statistical computing community. As a result, kernel density maps have been un-

derused in the quantitative analysis of biological data in comparison to histogram

maps, despite the well-documented evidence that kernel maps possess many favor-

able statistical properties over histograms (Simonoff, 1996; Wand & Jones, 1995).

Fortunately, the growing availability of the user-friendly, open-source statistical

computing software R, and especially the user-contributed add-on packages, has

brought advanced statistical analysis to a larger pool of users.

In order to create spatial density maps of intracellular compartments, fluorescent

microscopy images of endomembranes are segmented and the 3D spatial coordinates

of the structures are extracted. Typically, several tens to several hundred structures of

a specific compartment are extracted from each cell. Then, coordinates are replaced

by kernels and summed, revealing the underlying density of a protein throughout the

cell. The reproducible cellular orientation induced by the micropattern allows the

collation of several tens (or more) of cells, thus resulting in an average density

map for a population of analyzed cells. In addition to a visual summary, density maps

are used to derive statistics for quantitative analysis of cell morphology. Probability

contours indicate the regions of the highest local density/concentration of endomem-

branes (minimal regions for a given fixed proportion). They are useful because they

admit an intuitive probabilistic interpretation, for example, the 50% probability

contour defines the smallest region in which 50% of the endosomes are located.

Applying density mapping to Rab6, we have found that secretory vesicles, labeled

by this GTPase, preferentially localize at the adhesive edge of the cellular periphery

and are trapped there by the actin cytoskeleton.

Rationale
We will present how we exploit the advantages of the “micropatterning technique,”

which is to bring cells to adopt a highly reproducible shape, and probabilistic density

mapping that measures spatial organization of intracellular structures to quantita-

tively study the regulation of Rab6-labeled compartment by the cytoskeleton.

Rab6 is the most abundant Rab in the Golgi apparatus and it is also present on ve-

sicular post-Golgi transport carriers. It was found to be involved in several traffick-

ing steps, both in the secretory and retrograde pathways (Goud & Akhmanova,

2012). Rab6-labeled transport carriers move along microtubules from the Golgi to

the cell periphery, where some of them interact with cortical proteins and sub-

sequently fuse with the plasma membrane. We assess how Rab6-labeled transport

carriers are affected upon depolymerization of the cytoskeleton using nocodazole

or cytochalasin D, which, respectively, disrupt microtubules or actin filaments.
20.1 MATERIAL AND METHODS
The experimental procedure is outlined in Fig. 20.3. It includes the preparation of

micropatterned coverslips, cell plating, visualization of Rab6-labeled compartment,

imagingof several tens of cells, image segmentation, alignment, and densitymapping.



FIGURE 20.3

Schema of the experimental procedure. Micropatterned coverslips are prepared using

photolithography. Cells are plated onmicropatterns, structures of interest are visualized either

by expressing fluorescently tagged proteins or indirect immunofluorescence, and 3D images

are acquired. Images are deconvolved (if epifluorescence microscopy is used for 3D imaging)

and positional information of fluorescently labeled structures is extracted from each single cell

by segmentation analysis. Coordinates are aligned using the micropattern and the probability

density map is calculated throughout the cell. To visualize the result, equally spaced

probability contours are calculated that represent smallest areas in which a given percentage

of structures are found.

33120.1 Material and Methods
20.1.1 Specific materials (excluding generic products)
• hTERT-RPE1 cells stably expressing EGFP-Rab6

• PLL(20)-g[3.5]-PEG(2) (PLL-g-PEG, poly-L-lysine-g-poly(ethyleneglycol), Surface
Solutions), keep a stock solution at 1 mg/ml in 10 mM HEPES (pH 7.3) at 4 �C

• Photomask (Delta Mask)

• UVO Cleaner (Model 342-220, Jelight Company)

• Fibronectin

• Alexa-labeled fibrinogen (Amersham or Molecular Probes)

• 16% formaldehyde

• PBS/saponin/BSA (10� stock solution: 20 gBSA, 5 g saponin, and 1 l PBS 10�).
20.1.2 Methods
20.1.2.1 Preparation of micropatterns with photolithography
All steps have to be performed with the minimization of dust that will interfere with

pattern quality. First, coverslips are cleaned by irradiation with UV light in the UV

cleaner for 5 min. Coverslips are coated with PLL-g-PEG for 1 h, upside down in a

wet chamber on parafilm, using 15 ml (12 mm ∅) or 30 ml (18 mm ∅) of 0.1 mg/ml

PLL-g-PEG in 10 mM HEPES, pH 7.3. Coverslips are washed 2� with PBS and
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1� with ddH2O using a multiwell plate and dried with the PEG-treated (hydropho-

bic) surface up. Before printing the micropatterns, the photomask is first rinsed with

ddH2O and then with ethanol, dried with airflow, and eradiated with deep-UV light

for 5 min. Then, 4 ml (12 mm ∅) or 6 ml (18 mm ∅) of ddH2O is pipetted on the

photomask and coverslips are attached upside down on the mask using the capillary

pressure. Extra water is removed with a tissue, until coverslips do not move anymore,

and coverslips are covered with a big, thin glass plate or plastic film (e.g., old West-

ern blot film). The photomask with attached coverslips is carefully installed upside

down under the UV lamp of the UV cleaner and eradiated for 6 min. The UV light

(30–33 mW/cm2, measured at 254 nm) passes through the micropattern shapes and

changes the chemistry of the PLL-g-PEG layer (Azioune, Storch, Bornens, Thery, &

Piel, 2009). Then, the photomask is removed from the UV cleaner and covered

with plenteous water to remove the coverslips (coverslips will float). Coverslips

are dried upright under a cover and stored for up to 4 weeks in multiwell plates

until use.

20.1.2.2 Cell seeding, treatment, and fixation
Before cell plating, fibronectin is diluted to a final concentration of 50 mg/ml in

ddH2O using 20 ml for a 12 mm ∅ or 30 ml for a 18 mm ∅ coverslip. To visualize

micropatterns, Alexa-labeled fibrinogen is added at a final concentration of 5 mg/ml

to the fibronectin solution. Coverslips are placed with the patterned surface on the

mix and incubated for 1 h in the dark, in a wet chamber on parafilm. Afterward, they

are incubated in plain DMEM/F12 medium/20 mM HEPES in a multiwell plate for

5 min, at 37 �C. Meanwhile, cells are trypsinized (60–80% confluence, grown for

3 days) and resuspended in full medium (DMEM/F12, 10% FBS, and 1% penicillin/

streptomycin) in order to inactivate the trypsin. To obtain single cells, they are passed

several times through the pipette and then added dropwise onto the coverslips

(�300,000 cells). Cells are incubated for 5 min at room temperature (RT) (RPE-1 cells)

or for 20 min in the incubator (HeLa cells). Because the attachment timevaries between

different cell lines, this parameter needs to be adjusted accordingly. Generally, wewait

until the cells are attaching (1cell per pattern) and the rest are still floating.Cells are then

washed3–10�withplainmedium/20 mMHEPESinorder to removeall unboundcells.

As the surface of coverslips is more hydrophobic than under classical cell culture

conditions, some medium should always be left in the well to avoid drying out of the

coverslips, which will cause cell death. The cells are incubated at 37 �C for 2–5 h

for full spreading: RPE-1 cells require at least 2 h, and HeLa cells require at least

4 h. Typically, 25% of micropatterns are covered by a single cell, whereas the other

75% are either empty or covered by more than one cell. Once cells are spread, drugs

are added directly into the medium. In the case of drugs that depolymerize actin fila-

ments, only low concentrations are used to prevent cell rounding (e.g., 0.5 mMcytocha-

lasin D). To depolymerize microtubules, cells are placed at 4 �C for 1 h prior to the

addition of nocodazole (10 mM), a treatment that does not change cell shape. Cells

are fixed with 16% formaldehyde that is added directly to the cells to obtain a final

concentration of 4% and incubated for 15 min at room temperature.
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20.1.2.3 Immunolabeling (optional)
After cell fixation, formaldehyde is quenchedwith 50 mMNH4Cl for 5 min. Cells are

washed 3� with PBS and permeabilized with PBS/saponin/BSA for 20 min at RT.

Coverslips are then incubated upside down in a drop (20 ml for 12 mm∅ coverslips)

containing the primary antibody in 2% BSA in PBS, in a wet chamber, in the dark for

45 min. Then, coverslips arewashed 3�with PBSand incubated in the samewaywith

the secondary antibody followed by three washes with PBS and a short dip in ddH2O

(to removePBS crystals). Coverslips aremountedwithmowiol/DAPImix (ca. 5 ml for
a 12 mm ∅ coverslips) on an ethanol-cleaned slide and care is taken to avoid air

bubbles or moving of the coverslip, which may deform micropatterned cells.

20.1.2.4 Image acquisition of many single cells and preanalysis
Images are acquired with any conventional microscope using a magnification that

resolves the structures of interest. In the case of Rab6-labeled secretory vesicles,

a 63� or 100� objective is required. For a typical analysis, several tens of cells

(>20) are imaged; hence, microscopes with an automated stage are advantageous.

To obtain 3D density maps, z-dimension series are acquired every 0.2–0.3 mm and

out-of-focus signals should be avoided (either by using confocal microscopy or per-

forming deconvolution of epifluorescent images). To be able to process images in a

batch mode, the images need to be numbered logically. For each cell, images are

acquired for up to four fluorescence channels, including fluorescence staining of

the micropattern (e.g., Cy5), the nucleus (e.g., Dapi), and the intracellular structures

of interest (e.g., GFP). The nucleus staining is observed to verify that a single cell is

analyzed, as several cells are frequently attached onto a single micropattern. Images

of the structures of interest are segmented to extract their 3D spatial coordinates. This

step translates the gray values of a camera chip into numbers that define intracellular

structures. Several segmentation programs can be employed (Eliceiri et al., 2012),

such as the “multidimensional image analysis” interface in MetaMorph (Universal

Imaging Corporation) or “ParticleTracker.jar” in ImageJ (MOSAIC group, ETH,

http://www.mosaic.ethz.ch/Downloads/ParticleTracker; Sbalzarini & Koumoutsakos,

2005). After segmentation, the coordinates (centroids) of all structures of interest from

all cells are aligned using the micropattern. For this, coordinates of the center and the

angle of rotation of the micropattern are measured, either automatically or manually.

For automation, a macro can be established in ImageJ that chooses the most in-focus

image of the 3D stack of fluorescently labeled patterns and applies the ImageJ plug-

in “Hough Circles” to detect the center of a circle around the micropattern. Use a

micropattern-shapedmask to determine the angle of rotation to orient cells in one direc-

tion. This preanalysis will provide a table containing (aligned) coordinates for each

detected structure from several tens of cells. In supplementary data, you can find text

files (.txt) containing coordinates from the small GTPase Rab6, monitored in 82 non-

treated cells (Rab6NT82cells.txt), 50 cytochalasin D-treated cells (Rab6CD50cells.

txt), and 47 nocodazole-treated cells (Rab6NZ47cells.txt), all normalized by micro-

patterning. These coordinate tables are required to calculate corresponding density

maps for each condition.

http://www.mosaic.ethz.ch/Downloads/ParticleTracker
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20.1.2.5 Density mapping
The density estimation is performed using the ks library inR (R_Development_Core_

Team, 2013).R is a free programand can be downloaded and installed from theCRAN

(Comprehensive R Archive Network) Website (http://cran.r-project.org). It is avail-

able onmost platforms includingWindows,MacOS, andUnix/Linux. The procedure

for installing R is already well documented on this site. To visualize densitymaps, the

extension librariesmvtnorm, rgl,miscd, and ks are required that are available from the

CRANWebsite. Binary files are compiled versions of the source code and are the eas-

ier option. For those who have the ability and desire to compile the source code, this

requires certain libraries to be installed, including a gcc/Fortran77 compiler, X11

Windows server, and PNG libraries.

20.1.2.5.1 Program installation
1. Install the R base distribution from the R project Website http://www.r-project.

org under the CRAN rubric, for example, R-3.0.1.pkg (forMacintosh) or R-3.0.1-

win32.exe (for Windows).

2. Install the required extension packages. There are two main ways to do this.
a. Automatic: If the computer is connected to the Internet, packages can be

installed directly using the Package Manager interface inside R. This is the

preferred version as the most updated versions of the libraries will be

automatically installed. Note that networks with a proxy cache or firewall

may not allow for downloading in batch mode. Start R.

i. For Macintosh, select Packages & Data -> Package Installer. Make sure

that At User Level is selected for Install Location. Choose the CRAN

(binaries) under the Packages repository label. Click Get List.

ii. For Windows, select Packages -> Install Packages. Choose the

closestCRANmirror site. Thiswill bring up a list of all extension packages.
Scroll down to select ks, and press Install. Repeat for the rgl and misc3d libraries.

b. Manual: If the computer is not connected to the Internet, then the following

packagesmust be downloadedusing another computer fromCRAN:mvtnorm, rgl,

miscd, and ks. Go to theR projectWebsite ->CRAN.Choose aCRANmirror site.

Click on the Contributed extension packages link. This will bring up the list of all

contributed packages. Look for mvtnorm. Download the appropriate binary file

(.tgz for Macintosh and .zip for Windows) to the desktop (or other desired

location). Repeat for the ks, rgl, and misc3d libraries. Once all files have been

downloaded, start R. To install these extension packages, perform the following:

i. For Macintosh, select Packages & Data -> Package Installer. Then select

Local Binary Package under Packages Repository label. Select mvtnorm and

press Install.

ii. For Windows, select Packages -> Install Packages from local zip files.

Install the extension packages in this order: mvtnorm, ks, rgl, and misc3d.

http://cran.r-project.org
http://www.r-project.org
http://www.r-project.org
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20.1.2.5.2 Density estimation
Three simple commands in R produce a kernel density map: (i) Hpi() calculates the

optimal smoothing parameter for a density map, using a plug-in algorithm (Duong &

Hazelton, 2003); (ii) kde() computes the density map; and (iii) plot() creates a

graphical visualization of the density map.

smooth.param = Hpi(x=x)

density.map = kde(x=x, H=smooth.param)

plot(density.map)

The following procedure will calculate the density maps of the Rab6-labeled

compartment using the table of (aligned) coordinates for each detected structure

from several tens of cells obtained from the preanalysis. The text files, containing

coordinates of Rab6-labeled structures under different experimental conditions

and the R script required for the analysis, are provided in supplementary data. Save

these data into a dedicated folder that will be the working directory. For other exper-

imental conditions, coordinate tables of structures of interest need to be obtained and

the R script needs to be adjusted (e.g., exchange rab6.NT) in order to calculate cor-

responding density maps.

1. Start R and load the ks library.

This can be done by selecting Packages & Data -> Package Manager (Macintosh) or

Packages -> Load package (Windows), and then ks. Or it can be loaded by typing

library(ks) into the command line window.

2. Choose the working directory in which txt files for analysis are located.
(a) In Mac: ->Misc ->Change Working Directory

(b) In PC: ->File ->Change dir . . .

3. Open R script:

File ->Open Document . . .

4. Copy from R script the following script and paste in R Console:

## Load libraries

library(ks)

## Define calculation space

xlim2 <- c(-300,300)

ylim2 <- c(-300,300)

xlim <- c(-400,400)

ylim <- c(-400,400)

zlim <- c(-50, 100)

lwd <- 3

xmin <- -c(400,400,100)

xmax <- c(400,400,100)
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## Read in data files

rab6.NT <- read.table(file="Rab6NT82cells.txt", header=TRUE)

rab6.NZ <- read.table(file="Rab6NZ47cells.txt", header=TRUE)

rab6.CD <- read.table(file="Rab6CD50cells.txt", header=TRUE)

## Calculate density in 2D

H <- Hpi(rab6.NT[,1:2], binned=TRUE)

fhat2d.rab6.NT <- kde(x=rab6.NT[,1:2], H=H, xmin=xmin, xmax=xmax)

H <- Hpi(rab6.NZ[,1:2], binned=TRUE)

fhat2d.rab6.NZ <- kde(x=rab6.NZ[,1:2], H=H, xmin=xmin, xmax=xmax)

H <- Hpi(rab6.CD[,1:2], binned=TRUE)

fhat2d.rab6.CD <- kde(x=rab6.CD[,1:2], H=H, xmin=xmin, xmax=xmax)

## Calculate density in 3D

H <- Hpi(rab6.NT, binned=TRUE, bgridsize=rep(31,3))

fhat3d.rab6.NT <- kde(x=rab6.NT, H=H, xmin=xmin, xmax=xmax)

H <- Hpi(rab6.NZ, binned=TRUE, bgridsize=rep(31,3))

fhat3d.rab6.NZ <- kde(x=rab6.NZ, H=H, xmin=xmin, xmax=xmax)

H <- Hpi(rab6.CD, binned=TRUE, bgridsize=rep(31,3))

fhat3d.rab6.CD <- kde(x=rab6.CD, H=H, xmin=xmin, xmax=xmax)

## Create 2D plots

## 2D plotting functions

crossbow.3d <- array(0, dim=c(750, 750, 32))

crossbowt.3d <- crossbow.3d

contour.crossbow.2d <- function()

{

x.cross <- tail(seq(-350, 350, length=751), -1)

y.cross <- tail(seq(-350, 350, length=751), -1)

contour(x.cross, y.cross, crossbowt.3d[,,5], drawlabels=FALSE,

lwd=4, col="grey", cex.lab=1.4, cex.axis=1.4, asp=1, xlim=xlim2,

ylim=ylim2, xlab="x", ylab="y")

lines(c(-100-10000/64.5, -100), c(-300,-300), lwd=lwd)

text(-100-10000/64.5/2,-300, expression(10*" "*mu*m), pos=3,

cex=1.4)

}

## 2D plots

pdf(file="Rab6_NT.pdf")

par(mar=c(4,4,1,1), cex.main=1.4, lwd=lwd)

contour.crossbow.2d()

plot(fhat2d.rab6.NT, cont=25, col="red", add=TRUE, drawlabel=FALSE)

plot(fhat2d.rab6.NT, cont=50, col="orange", add=TRUE, drawlabel=FALSE)
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plot(fhat2d.rab6.NT, cont=75, col="yellow", add=TRUE, drawlabel=FALSE)

legend("bottomright", title="Rab6 NT", legend=c("25%", "50%", "75%"),

lwd=lwd,

col=c("red", "orange", "yellow"), bty="n", cex=1.2)

dev.off()

pdf(file="Rab6_NZ.pdf")

par(mar=c(4,4,1,1), cex.main=1.4, lwd=lwd)

contour.crossbow.2d()

plot(fhat2d.rab6.NZ, cont=25, col="red", add=TRUE, drawlabel=FALSE)

plot(fhat2d.rab6.NZ, cont=50, col="orange", add=TRUE, drawlabel=FALSE)

plot(fhat2d.rab6.NZ, cont=75, col="yellow", add=TRUE, drawlabel=FALSE)

legend("bottomright", title="Rab6 NZ", legend=c("25%", "50%", "75%"),

lwd=lwd,

col=c("red", "orange", "yellow"), bty="n", cex=1.2)

dev.off()

pdf(file="Rab6_CD.pdf")

par(mar=c(4,4,1,1), cex.main=1.4, lwd=lwd)

contour.crossbow.2d()

plot(fhat2d.rab6.CD, cont=25, col="red", add=TRUE, drawlabel=FALSE)

plot(fhat2d.rab6.CD, cont=50, col="orange", add=TRUE, drawlabel=FALSE)

plot(fhat2d.rab6.CD, cont=75, col="yellow", add=TRUE, drawlabel=FALSE)

legend("bottomright", title="Rab6 CD", legend=c("25%", "50%", "75%"),

lwd=lwd,

col=c("red", "orange", "yellow"), bty="n", cex=1.2)

dev.off()

## Create 3D plots

## 3D plotting functions

vv3d <- function()

{

par3d(userMatrix=matrix(c(0.87, -0.48, 0.04, 0, 0.10, 0.26, 0.96,

0, -0.48, -0.83, 0.29, 0, 0.00, 0.00, 0.00, 1), byrow=TRUE, ncol=4))

}

contour.crossbow.movie.3d <- function(add=TRUE, alpha=0.2, zoom=0.5)

{

par3d(windowRect=c(0,0,500*16/9,500), zoom=zoom)

ind <- seq(10, 750, by=10)

x.cross <- tail(seq(-350, 350, length=751), -1)[ind]

y.cross <- tail(seq(-350, 350, length=751), -1)[ind]

z.cross <- seq(-2000/645*4, 2000/645*27, length=32)

if (add)

axis3d(‘z+-’, at=seq(0, 100, length=5), pos=c(-100, 100, NA))

axis3d(‘x+’, pos=c(NA, 100, 0))
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axis3d(‘y+’, pos=c(-100, NA, 0))

text3d(-120, 120, 80, "z")

text3d(0, 150, 0, "x")

text3d(-130, 0, 0, "y")

vv3d()

}

rotatez.movie.3d <- function(file="movie.mpeg", start=0, end=2*pi,

len=100, n=1)

{

angle.step <- diff(seq(start, end, length=(n*len)))[1]

for (i in 1:(n*len))

{

par3d(userMatrix=rotate3d(par3d()$userMatrix,angle.step,0,0,1))

snapshot3d(file=paste(file, sprintf("%03d", i), ".png", sep=""))

}

if (.Platform$OS.type=="unix")

{

#system(paste("convert -delay 10 ", file, "*.png -loop 0 ", file, sep=""))

}

}

## 3d plots

plot(fhat3d.rab6.NT, col=c("yellow", "orange", "red"), xlim=xlim,

ylim=ylim, zlim=ylim, axes=FALSE, box=FALSE, asp=c(1,1,1), xlab="",

ylab="", zlab="")

contour.crossbow.movie.3d()

snapshot3d(file="Rab6_NT.png")

plot(fhat3d.rab6.NZ, col=c("yellow", "orange", "red"), xlim=xlim,

ylim=ylim, zlim=ylim, axes=FALSE, box=FALSE, asp=c(1,1,1), xlab="",

ylab="", zlab="")

contour.crossbow.movie.3d()

snapshot3d(file="Rab6_NZ.png")

plot(fhat3d.rab6.CD, col=c("yellow", "orange", "red"), xlim=xlim,

ylim=ylim, zlim=ylim, axes=FALSE, box=FALSE, asp=c(1,1,1), xlab="",

ylab="", zlab="")

contour.crossbow.movie.3d()

snapshot3d(file="Rab6_CD.png")

5. Additional options to save a movie of the 3D density map and to save and load the

calculated densities are provided by the following commands:

## 3d movies

rotatez.movie.3d()
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## save densities

save(list=ls(pattern="fhat*"), file="Rab6.RData")

## reload calculated densities

load("Rab6.RData")
20.2 RESULTS AND DISCUSSION
To demonstrate the potential of our method to detect alterations in intracellular traf-

ficking pathways, we analyze the Rab6-labeled compartment under different exper-

imental conditions as an example. Whereas treatment with nocodazole gives rise to a

strong phenotype that has been previously described (Grigoriev et al., 2007; Racine

et al., 2007), treatment with cytochalasin D leads to subtle morphological changes on

Rab6-labeled transport carriers. Nocodazole treatment fragments the Golgi and re-

distributes Rab6-labeled transport carriers from the cell periphery to the cell center, a

phenotype easily assessable in nonrestricted and micropatterned cells (Fig. 20.4C).

On the contrary, disruption of actin filaments does not show any strong effect in non-

constrained cells or micropatterned cells as judged by visual estimation (Fig. 20.4B).

Density mapping of the Rab6-labeled compartment in many normalized cells with dis-

rupted actin shows however retraction of transport carriers from peripheral adhesive

areas (Fig. 20.4B, right panel). This indicates that Rab6-labeled transport carriers are

entrapped at the edge of the cell by actin filaments. Actin filaments are known to be or-

ganized close to the cell surface and to spread out trafficking vesicles (Nascimento,

Roland, & Gelfand, 2003; Snider et al., 2004). To test for the significance of the differ-

encebetweencontrol cells andcytochalasinD-treatedcells, density-based testingcanbe

employed. Full automated testing can be performed using our multivariate two-sample

test that is asymptotically normal under the null hypothesis allowing “black box” com-

parisonsofmultivariatedata (Duongetal.,2012).Thecompletelyautomatic testingpro-

cedure (including the parameter estimation and the computation of the test statistic and

itsP-value) is programmed in theks library inR.Alternatively, resamplingmethods that

compute the critical quantiles of the null distribution can be used requiring calibration

for each data analysis at hand. For example, a distance function between pairs of points

from different experimental conditions can be comparedwith a corresponding distance

function from the same experimental condition (Schauer et al., 2010).

Alterations in intracellular trafficking are often revealed indirectly, mainly by the

missorting of marker molecules, such as cargo proteins that are exchanged among the

different intracellular compartments. Moreover, existing methods to study intracel-

lular trafficking alterations do not provide a quantitative way to characterize the spa-

tial distribution of the compartments, especially regarding those that are spatially

dispersed, like transport carriers. By allying the micropatterning technique with

probabilistic density maps, our method provides a direct and intuitive visualization

of subcellular alterations in trafficking compartments. Therefore, it is extremely use-

ful in the assignment of functional roles to trafficking components. In the future, it

will be interesting to use this method to investigate whether patterned cells could be



FIGURE 20.4

Changes of Rab6-labeled compartment upon cytoskeletal disruption. (A) Rab6-labeled

compartment in nontreated cells. Nonconstrained and micropatterned cells and the

corresponding 2D and 3D density maps of 82 normalized cells are shown. (B) Rab6-labeled

compartment upon cytochalasin D treatment in nonconstrained and micropatterned cells

and the corresponding 2D and 3D density maps of 50 normalized cells. (C) Rab6-labeled

compartment upon nocodazole treatment in nonconstrained and micropatterned cells and

the corresponding 2D and 3D density maps of 47 normalized cells. The 25% (red), 50%

(orange), and 75% (yellow) probability contours represent the smallest area in which a given

percentage of Rab6-labeled structures are found: for example, the 50% probability contour

defines the smallest area in which 50% of structures are located. Scale bars, 10 mm.
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used as references to rapidly highlight pathological disorders, for example, during

malignant development. Furthermore, this approach is a step towards the establish-

ment of automated proceedings for high-content, high-throughput, phenotype-based

screenings (Schauer et al., 2013). For instance, it could be used to identify scaffold,

tether, or motor proteins that are regulated by a distinct Rab protein, for example,

Rab6. As our method provides quantitative data from density-based analyses, we en-

vision to use them for modeling approaches that could allow a better understanding

of changes in intracellular organization of compartments in health and disease.
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SUMMARY

Crossing the border between different scientific disciplines is required to quantify

changes in cellular morphology in a robust, unbiased, and automated manner in high

throughput. We present how an advanced mathematical method, density estimation,

is employed to move to quantitative cell biology, allowing detailed analysis of com-

plex cellular behavior.
Acknowledgments
We thank Laura Picas and Lena Oesterlin for critical reading of the chapter. K. S. received

funding from the Fondation pour la Recherche Médicale en France and Association pour la

Recherche sur le Cancer. T. D. received funding from the program “Investissements d’avenir”

ANR-10-IAIHU-06. C. S. G. S. is supported by the Marie Curie Fellowship PIEF-GA-2011-

299756. This project was further supported by grants from Agence Nationale de la Recherche

(#2010 BLAN 122902), the Centre National de la Recherche Scientifique, and Institut Curie.

Conflict of interest statement: A patent (PCT n� EP2012/064239) has been filed on the

density-based two-sample test.
References
Azioune, A., Storch, M., Bornens, M., Thery, M., & Piel, M. (2009). Simple and rapid process

for single cell micro-patterning. Lab on a Chip, 9, 1640–1642.
Becker, T., Volchuk, A., & Rothman, J. E. (2005). Differential use of endoplasmic reticulum

membrane for phagocytosis in J774 macrophages. Proceedings of the National Academy
of Sciences of the United States of America, 102, 4022–4026.

Bonifacino, J. S., & Glick, B. S. (2004). The mechanisms of vesicle budding and fusion. Cell,
116, 153–166.

Chia, P. Z., & Gleeson, P. A. (2011). The regulation of endosome-to-Golgi retrograde trans-

port by tethers and scaffolds. Traffic, 12, 939–947.
Duong, T., Goud, B., & Schauer, K. (2012). Closed-form density-based framework for auto-

matic detection of cellular morphology changes. Proceedings of the National Academy of
Sciences of the United States of America, 109, 8382–8387.

Duong, T., & Hazelton, M. L. (2003). Plug-in bandwidth matrices for bivariate kernel density

estimations. Journal of Nonparametric Statistics, 17, 17–30.
Duong, T., & Hazelton, M. L. (2005). Cross-validation bandwidth matrices for multivariate

kernel density estimation. Scandinavian Journal of Statistics, 32, 485–506.
Eliceiri, K. W., Berthold, M. R., Goldberg, I. G., Ibanez, L., Manjunath, B. S., Martone, M. E.,

et al. (2012). Biological imaging software tools. Nature Methods, 9, 697–710.
Ellis, M. A., Potter, B. A., Cresawn, K. O., &Weisz, O. A. (2006). Polarized biosynthetic traf-

fic in renal epithelial cells: Sorting, sorting, everywhere. American Journal of Physiology
Renal Physiology, 291, F707–F713.

Folch, A., & Toner, M. (2000). Microengineering of cellular interactions. Annual Review of
Biomedical Engineering, 2, 227–256.

Goud, B., & Akhmanova, A. (2012). Rab6 GTPase. Danvers: Bentham Science.

http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0005
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0005
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0010
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0010
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0010
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0015
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0015
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0020
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0020
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0025
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0025
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0025
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0030
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0030
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0035
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0035
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0040
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0040
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0045
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0045
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0045
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0050
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0050
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0055


342 CHAPTER 20 Traffic in Constrained (Patterned) Cells
Griffiths, G., Back, R., & Marsh, M. (1989). A quantitative analysis of the endocytic pathway

in baby hamster kidney cells. The Journal of Cell Biology, 109, 2703–2720.
Grigoriev, I., Splinter, D., Keijzer, N., Wulf, P. S., Demmers, J., Ohtsuka, T., et al. (2007). Rab6

regulates transport and targeting of exocytotic carriers. Developmental Cell, 13, 305–314.
Gumbiner, B. M. (1996). Cell adhesion: The molecular basis of tissue architecture and mor-

phogenesis. Cell, 84, 345–357.
Hutagalung, A. H., & Novick, P. J. (2011). Role of Rab GTPases in membrane traffic and cell

physiology. Physiological Reviews, 91, 119–149.
Jean, S., & Kiger, A. A. (2012). Coordination between RAB GTPase and phosphoinositide

regulation and functions. Nature Reviews Molecular Cell Biology, 13, 463–470.
Lipschutz, J. H., Lingappa, V. R., & Mostov, K. E. (2003). The exocyst affects protein syn-

thesis by acting on the translocation machinery of the endoplasmic reticulum. Journal of
Biological Chemistry, 278, 20954–20960.

Markgraf, D. F., Peplowska, K., & Ungermann, C. (2007). Rab cascades and tethering factors

in the endomembrane system. FEBS Letters, 581, 2125–2130.
Martinez-Menarguez, J. A., Geuze, H. J., Slot, J. W., & Klumperman, J. (1999). Vesicular tu-

bular clusters between the ER and Golgi mediate concentration of soluble secretory pro-

teins by exclusion from COPI-coated vesicles. Cell, 98, 81–90.
McBeath, R., Pirone, D. M., Nelson, C. M., Bhadriraju, K., & Chen, C. S. (2004). Cell shape,

cytoskeletal tension, and RhoA regulate stem cell lineage commitment. Developmental
Cell, 6, 483–495.

Nascimento, A. A., Roland, J. T., &Gelfand, V. I. (2003). Pigment cells: Amodel for the study

of organelle transport. Annual Review of Cell and Developmental Biology, 19, 469–491.
Pereira-Leal, J. B., & Seabra, M. C. (2001). Evolution of the Rab family of small GTP-binding

proteins. Journal of Molecular Biology, 313, 889–901.
R_Development_Core_Team (2013). R: A language and environment for statistical comput-

ing. Vienna, Austria: R Foundation for Statistical Computing.

Racine, V., Sachse, M., Salamero, J., Fraisier, V., Trubuil, A., & Sibarita, J. B. (2007). Visu-

alization and quantification of vesicle trafficking on a three-dimensional cytoskeleton net-

work in living cells. Journal of Microscopy, 225, 214–228.
Sannerud, R., Saraste, J., & Goud, B. (2003). Retrograde traffic in the biosynthetic-secretory

route: Pathways and machinery. Current Opinion in Cell Biology, 15, 438–445.
Saraste, J., &Goud, B. (2007). Functional symmetry of endomembranes.Molecular Biology of

the Cell, 18, 1430–1436.
Sbalzarini, I. F., & Koumoutsakos, P. (2005). Feature point tracking and trajectory analysis for

video imaging in cell biology. Journal of Structural Biology, 151, 182–195.
Schauer, K., Duong, T., Bleakley, K., Bardin, S., Bornens, M., & Goud, B. (2010). Probabi-

listic density maps to study global endomembrane organization. Nature Methods, 7,
560–566.

Schauer, K., Grossier, J.-P., Duong, T., Chapuis, V., Degot, S., Lescure, A., et al. (2013).

A novel “Organelle Map” framework for high-content cell morphology analysis in

high-throughput. Journal of Biomolecular Screening, 2013, Aug 16. [Epub ahead of print].
Sigal, A., Milo, R., Cohen, A., Geva-Zatorsky, N., Klein, Y., Liron, Y., et al. (2006). Variabil-

ity and memory of protein levels in human cells. Nature, 444, 643–646.
Simonoff, J. S. (1996). Smoothing methods in statistics. New York: Springer-Verlag.

Snider, J., Lin, F., Zahedi, N., Rodionov, V., Yu, C. C., & Gross, S. P. (2004).

Intracellular actin-based transport: How far you go depends on how often you switch.

Proceedings of the National Academy of Sciences of the United States of America, 101,
13204–13209.

http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0060
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0060
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0065
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0065
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0070
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0070
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0075
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0075
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0080
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0080
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0085
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0085
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0085
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0090
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0090
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0095
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0095
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0095
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0100
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0100
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0100
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0105
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0105
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0110
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0110
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0115
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0115
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0120
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0120
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0120
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0125
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0125
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0130
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0130
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0135
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0135
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0140
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0140
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0140
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0145
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0145
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0145
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0150
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0150
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0155
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0160
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0160
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0160
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0160


343References
Snijder, B., Sacher, R., Ramo, P., Damm, E. M., Liberali, P., & Pelkmans, L. (2009). Popu-

lation context determines cell-to-cell variability in endocytosis and virus infection.Nature,
461, 520–523.

Stenmark, H. (2009). Rab GTPases as coordinators of vesicle traffic. Nature Reviews Molec-
ular Cell Biology, 10, 513–525.

Thery, M., Racine, V., Pepin, A., Piel, M., Chen, Y., Sibarita, J. B., et al. (2005). The extra-

cellular matrix guides the orientation of the cell division axis. Nature Cell Biology, 7,
947–953.

Thery, M., Racine, V., Piel, M., Pepin, A., Dimitrov, A., Chen, Y., et al. (2006). Anisotropy of

cell adhesive microenvironment governs cell internal organization and orientation of po-

larity. Proceedings of the National Academy of Sciences of the United States of America,
103, 19771–19776.

Toikkanen, J. H., Miller, K. J., Soderlund, H., Jantti, J., & Keranen, S. (2003). The beta subunit

of the Sec61p endoplasmic reticulum translocon interacts with the exocyst complex in

Saccharomyces cerevisiae. Journal of Biological Chemistry, 278, 20946–20953.
Wand, M. P., & Jones, M. C. (1995). Kernel smoothing. London: Chapman & Hall/CRC.

Wilcke, M., Johannes, L., Galli, T., Mayau, V., Goud, B., & Salamero, J. (2000). Rab11

regulates the compartmentalization of early endosomes required for efficient transport

from early endosomes to the trans-golgi network. The Journal of Cell Biology, 151,
1207–1220.

http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0165
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0165
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0165
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0170
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0170
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0175
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0175
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0175
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0180
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0180
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0180
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0180
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0185
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0185
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0185
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0190
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0195
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0195
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0195
http://refhub.elsevier.com/B978-0-12-417164-0.00020-3/rf0195

	Studying Intracellular
Trafficking Pathways with
Probabilistic Density Maps
	Abstract
	Introduction
	Intracellular trafficking pathways
	Cell confinement by micropatterning techniques
	Probabilistic density mapping of intracellular compartments
	Rationale

	Material and Methods
	Specific materials (excluding generic products)
	Methods
	Preparation of micropatterns with photolithography
	Cell seeding, treatment, and fixation
	Immunolabeling (optional)
	Image acquisition of many single cells and preanalysis
	Density mapping
	Program installation
	Density estimation



	Results and Discussion
	Summary
	Acknowledgments
	References




